
 

6:00 pm – Continuing with our tour of Windows 10, we’ll 
learn how to customize the Start Menu and Taskbar. 
 
At 7:00 pm, we’ll be celebrating National Cyber Security 
Awareness Month (NCSAM) with a presentation on 
Online Security – What you need to know to browse the 
Web safely.  
 
NCSAM was created as a collaborative effort between 
government and industry to ensure every American has 
the resources they need to stay safer and more secure 
online.  
 
Each and every one of us needs to do our part to make 
sure that our online lives are kept safe and secure; this 
presentation will give you some resources to do that.  
 
The SCV Computer Club is a NCSAM Champion – we 
were featured in the 2nd row of Champions yesterday. 
www.staysafeonline.org  
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Scam I Am 
By Greg Skalka, President, Under 
the Computer Hood User Group 
April 2015 issue, Drive Light 
www.uchug.org  
president (at) uchug.org 

 
I don’t like things to slow me down 
The web is made to click around 

Passwords are a royal pain 
There’s no room for them inside my brain 

 
My inbox may be filled with spam 
But I’m not worried about a scam 
Google’s tracking helps me shop 
My Facebook postings never stop 

 
Hackers will not target me 

There are bigger fish in the world-wide sea 
My check has bounced - there’s no money left 

Oh no!  I’m a victim of identity theft! 
 

Scams, cons, theft and deceit have been around forever. Just as technology has helped 
us increase our productivity, it has helped the crooks become more efficient as well.  The 
old scams and trickery have been made easier to execute, while new forms of theft have 
been developed. 
 
The authenticity of bank robber Willie Sutton’s quote about why he robbed banks, 
“Because that’s where the money is”, may be in question, but robbers today still go where 
there are things of value. Now their targets are subscriber personal data at Anthem Blue 
Cross, credit card information at Target and account information from phishing attempts on 
individuals through email. 
 
With so many institutions, from banks, retailers, insurance companies, medical providers 
and even the government holding sensitive information about us and apparently not 
protecting it all that well, we are all at high risk of institutional data theft, though there is not 
much we can do to prevent it. For most of us, hiding out in the woods with no legal 
residence, credit cards or medical coverage is not an option.  I have Anthem Blue Cross 
health insurance, so since their announcement of the loss of subscriber data through a 
cyber-attack, all I can do is take advantage of their offer of free credit monitoring and 
identity theft protection, and watch my accounts and credit reports carefully. While we can’t 
do much about the institutional data hacks, we can do a better job of protecting ourselves 
from those threats that target us individually. 
 
There is a strong correlation between crime rates and the proximity to a freeway onramp; 
access to a highway facilitates finding victims and provides criminals a quick and easy 
getaway. The connection to the Information Superhighway we get through our computers, 



  
DATALINE                                               October 2015                                                             3 

tablets and smart phones works in the same way, bringing the potential for crime closer to 
us. Now financial misfortune can be as close as our inboxes or browsers. 
 
We have all received those ridiculous emails reported to be from Nigerian customs 
officials, foreign attorneys and even the head of the FBI, asking for help or offering huge 
sums of money for us to claim. It is hard to believe anyone falls for these scams anymore, 
yet I still continue to receive the emails. I’ve also received many emails that appear to be 
from banks, credit card companies and online services, but are really phishing attempts.  
These are generated by criminals intent on tricking me into providing them with my 
sensitive information. A lot of them are easy to spot; they may be from institutions I don’t 
have accounts with, or may have misspellings or other flaws that are a tip-off that they are 
fakes. I have received some very convincing phishing emails, however. Either by random 
chance or because the scammers knew I had an account there, I’ve received emails that 
appeared legitimate and pertinent to my situation, but after close examination and 
research, turned out to be fakes intended to scam me. 
 
With income tax filing season in full swing, the media is presently full of warnings about 
email and phone scams related to the IRS.  We hear about all these scams and hacks; 
hopefully we take these warnings seriously and don’t disregard them as things that only 
happen to others.  I’d heard about phone scams where callers try to convince you that a 
loved one is in trouble and you must send money to help them, but I never considered 
them a serious threat until someone tried to scam my mother. 
 
A few weeks ago, my mom called our home and asked if our daughter was all right. She 
then told us the story of the scam call she had just received. Fortunately, she was 
suspicious and did not get taken. It is not clear if she was targeted specifically by 
scammers with knowledge of our family situation, or if it was just a random call. 
 
When my mom answered the scam call, a young female voice said “Hi Grandma.” Since 
she has only one granddaughter, my mom replied “Hi Alli”, so it is not clear the caller knew 
my twenty-four-year-old daughter’s name beforehand. 
 
The caller initially engaged briefly in some small talk, like how have you been and such, 
but then, either having some knowledge or taking a chance, asked if Grandpa was there.  
The scam would have been exposed at that point had my father been deceased, but 
fortunately he was there. 
 
The caller then said “Grandma, I’m in trouble, but you have to promise not to tell anyone 
else in the family about this. Can you do that, Grandma?” 
 
My mom was getting a little suspicious, but agreed. 
 
The caller went on. “Grandma, a good friend of mine died suddenly and I’m in Virginia for 
the funeral.  Because she was Jewish, they had to bury her right away, so I had to travel 
on short notice. After the funeral, some other friends and I stopped at a restaurant for a 
drink before returning to our hotels. I only had one drink, but because I was also taking 
antibiotics for bronchitis, I hit a street light and knocked it over on the way back.” 
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The addition of bronchitis to the scam narrative is interesting as it generates sympathy for 
the caller (she is not just a drunk) and could explain why she perhaps did not sound quite 
like my daughter. This scam would understandably work best on grandparents that don’t 
often get calls from their granddaughters. I’m certain my wife and I would have been able 
to recognize our daughter’s voice had we been called. 
 
The caller continued. “Grandma, I’m at the police station here. They said they would not 
charge me with anything if I could pay for the damaged street light, but I don’t have the 
money. A lawyer here is willing to pay for it on my behalf if you can send him the money.  
Here is a policeman.” 
 
A male voice came on the line. “Hello, this is Officer Raleigh. Your granddaughter needs 
you to send $2300 to cover the damage to the street light, and then we can release her 
with no charges. Can you do that?”  Officer Raleigh then provided detailed instructions to 
my mom on sending the money. She was to take $2300 in cash, with two IDs, to a 
Walmart and send it via Western Union MoneyGram to Ronald Pearlman in Bristol, 
Virginia. When Officer Raleigh asked if she understood all of this, my mom replied that she 
didn’t think all this sounded right. 
 
Officer Raleigh put the phone down for a minute, as if he was not sure what to say. When 
he came back to the call, he began repeating the payment instructions again. When my 
mom again said she didn’t think this sounded right, Officer Raleigh hung up. The scam 
was thwarted. 
 
I told my mom’s story to a coworker a few days later and she said a similar thing had 
happened to her relatives in Mexico, except that it was kidnappers calling to say they had 
their daughter. Her relatives unfortunately paid $1500 before finding out their daughter had 
been safe at a friend’s house all along. 
 
With all our personal information entrusted to companies and the Internet, hackers and 
crooks can have a much easier job deceiving us. To avoid being taken advantage of by 
these thieves, we all must unfortunately be more suspicious and skeptical. Just because 
you’re paranoid doesn’t mean they are not out to scam you. 
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Nibblers 
By Jeannine Sloan, Ambassador for Friendship Village, Twin 
Cities PC Club, MN 
June 2015 issue, The Digital VIKING 
www.tcpc.com / sqwalbran (at) yahoo.com 

 
 
Modular Smart Phones  
Project Ara is a plan for a modular smartphone from Google's Advanced Technology and 
Projects group, the California-based search engine's research and development brain 
trust. You'll build your phone from modules you choose, each module a square of varying 
size that attaches to the phone with electropermanent magnets.  
http://www.cnet.com/news/googles-modular-smartphone-project-ara-gets-one-step-closer/  
  
Media Streaming Sites Compared  
This article is intended to be a concise comparison of some of the top streaming services 
available. Below, you’ll find them stacked against each other and compared in the areas of 
content selection, pricing, and availability to help you find the service that best suits your 
needs. Read more:  
http://www.digitaltrends.com/home-theater/best-media-streaming-services-version-
1429724876/#ixzz3YW1ucTpo  
  
Biometric Scanning  
Bodyprint is a research project, and not something ready to be integrated into our 
smartphones. However, it proves the potential is there for the future, and biometric 
scanning doesn’t have to be limited to the most expensive devices. Read more:  
http://www.digitaltrends.com/mobile/bodyprint-biometric-capacitive-screen-scanner-
news/#ixzz3YW0EvKiN  
  
Ransomware Defenses  
To protect yourself from newer "crypto" infections, ensure that whatever email service you 
use has filtering enabled to remove malicious attachments. Or forward your mail through 
Gmail, which generally does a good job of blocking suspect attachments. 
http://tinyurl.com/k9utnvw  
  
Google Earth Tutorials  
This set of tutorials can help you understand how to use the fun, powerful features of 
Google Earth. Each tutorial provides a hands-on lesson using the application. Tutorials 
topics include:  

 Navigating on the Earth  

 Searching for locations and businesses  



  
DATALINE                                               October 2015                                                             6 

 Marking locations  

 Exploring Mars, Moon, and Sky (video)  

 Geotagging photos using Picasa (video, English)  

 Obtaining coordinates (video, English only)  

 Making movies in Google Earth Pro and EC  

 Importing addresses in Google Earth Pro and EC 
https://support.google.com/earth/answer/176576?hl=en  

  
Next-Generation Firewall  
A next-gen firewall can look inside the envelope to check it also doesn't contain dangerous 
content. Likewise, it can have smarter rules so you can say "block all known dodgy 
addresses" rather than having to explicitly state "don’t allow mail from Joe the scammer at 
number 23 Spam Lane." The great thing about these smart rules is that you can transfer 
the responsibility for keeping an updated list of dodgy addresses to your firewall vendor 
rather than maintaining them manually yourself.  
http://tinyurl.com/o4749p5  
  
dxdiag  
All Windows computers have this tool. It can provide lots of information.  
DxDiag is a commonly requested file when dealing with tech problems. It contains 
information about the hardware your computer has and all sorts of other helpful 
information. This file does not contain any sort of personal information. How to obtain your 
DxDiag file:  
From the desktop click: Start > Run (or windows key + r).  
In the blank text field of the window that appears type “dxdiag” without the quotes. Press 
run or hit enter.  
 
Another window should appear titled DirectX Diagnostic Tool. Near the bottom of the 
window click on “Save All Information…” A popup should appear with a progress bar, this 
may take a few minutes.  
 
After it completes a dialog should appear asking you where to save the file. 
Recommended: save it to your desktop (automatically selected) with the default name and 
file type.  
  
Fun Website  
Some will crow and others will lament how their crow’s feet prematurely age them after 
uploading a photo of themselves to Microsoft’s age-guessing How Old Robot. But this fun 
website presages a future in which computers can make sophisticated predictions and 
decisions based on who they're looking at.  
http://how-old.net/# (This site said I look 10 years younger than I am, love it.)  
  
This Device Lets People Communicate Without A Cell Signal, Wi-Fi, or Power  
The designers are currently finishing their final proof of concept and coordinating with the 
Philippines Red Cross to plan a rollout across the country. Eventually, they hope to bring it 
to other countries as well. It's something that could be useful anywhere; even the most-
connected places on Earth can't easily communicate when standard infrastructure breaks. 
http://www.fastcoexist.com/3045723/  
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Edge’s Security  
Microsoft Edge will defend against common trickery tactics used by hackers to obtain 
personal information or money, such as phishing, through stronger credentials. Windows 
10 will also have Microsoft Passport, a technology that uses asymmetric cryptography to 
authenticate you to your frequently visited websites. With SmartScreen, Edge will be able 
to perform a reputation check on all websites you browse. Additionally, it will block sites 
that it deems prone to phishing.  
Read more: http://www.digitaltrends.com/computing/microsoft-edge-
security/#ixzz3a1nsuM5p  
  
Tech Companies Are Moving To 100% Clean Energy, Some Faster Than Others  
With people storing gigabytes-worth of selfies online and live-streaming their naps, cloud 
data centers from companies like Apple, Amazon, and Facebook demand more and more 
electricity these days. Greenpeace research is being analyzed, examined, praised and 
criticized. Read the article here:  
http://www.fastcoexist.com/3046195/  
  
Zero Energy Furniture  
The ZEF program addresses an open problem: how solving energy efficiency and climate 
control issues at the furniture scale rather than at the building scale? 
http://zefdesign.tumblr.com/manifesto  
 
The first product, a table looks fairly ordinary. But when the room around it heats up, the 
table automatically starts to cool the air. When it gets cold, the table warms things back up. 
All of this happens without any outside energy use: Instead, the table automatically keeps 
things comfortable through a hidden layer of a special kind of wax and some simple 
physics.  
http://www.fastcoexist.com/3046023/  
  
The Rubber Army  
Before he became an acclaimed fashion designer, Bill Blass created deliberately bad 
camouflage during World War II as a member of the so-called "Ghost Army." Check out 
the slide show for an illustrated guide to harmless military equipment and read on for a 
primer in Ghost Army misdirection.  
http://www.fastcocreate.com/3045935/  
  
ID Picture Contents  
Load a picture in the box on this site and the site will make its best effort to identify the 
object. Try it here:  
https://www.imageidentify.com/  
  
YouTube Privacy  
A YouTube video on how to make your Facebook completely private. I will run the video as 
I make the changes because there is so much information. 
https://www.youtube.com/watch?v=_vqrXIsAPXk  Contributed by Sally Northrop  
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Thirty-Seven Things You Should Keep In Your Car  
Packing light has its advantages, but having some items – from a roll of quarters to a roll of 
duct tape – in your car all the time can be a big help when needs arise.  
http://www.csmonitor.com/Business/Saving-Money/2015/0517/Thirty-seven-things-you-
should-always-keep-in-your-car  
  
Microsoft Match  
Answer six quick questions and Microsoft Match from Staples, will find the best suitable 
Windows device for you. More the choices, the bigger is the confusion. Windows offer too 
many great devices with highly advanced features and specifications, but not every device 
might suit your actual requirements. Microsoft now wants to help users selecting the 
correct device for them.  
http://www.staples.com/sbd/cre/products/microsoft/match/index.html  
  
Display a Program’s Startup Impact on Windows  
Windows 8 displays startup information in the Windows Task Manager and not in 
msconfig. There you find listed a selection of programs that start with Windows. The 
startup impact column highlights programs that have a high impact on the system's startup 
which can be useful in determining whether you should disable the autostart of a program 
listed there. Use Ctrl-Shift-Esc to open the Task Manager. It is alternatively possible to 
right-click on the taskbar and select Task Manager from the context menu that opens up.  
 
Switch to the Startup tab once the Task Manager has loaded.  
There you find listed the startup impact column. You can sort it with a click on the column 
header.   
http://tinyurl.com/nv6aljw  
  
Device Guard Joins Windows  
Device Guard, announced at last month's RSA Conference in San Francisco, will be an 
option for those who want deeper protection against APTs and malware in instances 
where intruders get in.  
https://redmondmag.com/blogs/the-schwartz-report/2015/05/device-guard-lockdown-
windows-10.aspx  
  
Portable Power  
If you travel for business regularly a useful accessory to carry is a mobile battery pack to 
keep phones and tablets running for hours. That's easy to do with the Cheero Power Plus 
3 that packs a whopping 13,400 mAh battery in a gadget only 3.8 x 3.1 inches small. The 
Cheero has two USB ports and can charge two devices at the same time. 
http://tinyurl.com/pwhwjcl  
  
Windows 8 Recovery Media  
Recovery media is kindergarten simple to create in Windows 8. I used a 1GB USB drive 
and completed the project in less than 15 minutes. I hope I never need it but it gives me 
peace of mind to have it. The instructions here: http://windows.microsoft.com/en-
us/windows-8/create-usb-recovery-drive  
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Emoji Count Increasing in 2016  
The Unicode emoji subcommittee (yes, such a thing exists) finalized and submitted a list of 
38 new emojis for encoding in version 9.0 of the Unicode Standard, The proposal 
document includes notes for each new emoji, which contains some entertaining tidbits. For 
instance, the emoji subcommittee says the left-facing and right facing-fists can be used in 
tandem to create a fist bump.  
  
Read more: http://www.digitaltrends.com/web/38-new-emojis-could-be-coming-in-2016-
including-baconselfie-avocado-call-me/#ixzz3b44H4e5G  
Link to Wikipedia article defining current emoji: http://en.wikipedia.org/wiki/Emoji  
  
Extend the Life of your Gadget’s Batteries  
Tips to help maintain the health of Lithium Ion batteries:  
Avoid deep discharge;  
Charge devices to around 50% before storing;  
Never store a device that is either fully charged or completely discharged for extended 
periods. Tips like this and more are explained in this article. Read it here: 
http://tinyurl.com/mlwf6lp  
  
Juice Jacking  
The process of charging smart devices at public kiosks is a route to infection and/or data 
loss. Follow these guidelines if you must use a public charging kiosk. 
http://www.techadvisory.org/2014/09/whatsjuicejacking  
 

 
Google’s New Spam-Fighting Tools 
By Bob Rankin, Ask Bob Rankin  
July 23, 2015 Column  
bob (at) rankin.org 
Reprinted with Permission 
 
 
Google estimates that nearly 60 percent of all email it processes is spam. But like most 
Gmail users, I rarely see any spam in my inbox. Google claims that Gmail now blocks 99.9 
percent of all spam. Read on to learn how you can get near-perfect spam filtering, even if 
you don't use Gmail... 
 
Machine learning, an application of artificial intelligence, has been part of Gmail’s spam 
filter program since Gmail’s inception. On July 9, Google announced three new 
improvements to Gmail’s spam filter. 
 
Every time a user clicks the “Report Spam” or “Not Spam” button on a message, Gmail 
learns something that helps it filter spam better. But now, Gmail is attempting to learn on 
its own, without the user’s clicks. 
 

http://www.techadvisory.org/2014/09/whatsjuicejacking
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The spam filter now uses the same artificial neural network that Google Now and Google 
Search use to detect and block the “especially sneaky” spam that sometimes slips past 
users’ radar. 
 
Gmail Spam Filter 
What’s an “artificial neural network,” you ask? The oversimplified answer is, a lot of 
computers connected to each other in an attempt to simulate the interconnections of 
human brain cells. It’s expensive to build an artificial neural network; most are tiny, with 1 
to 10 million connections. 
 

Google has built an ANN with over one billion connections 
using the processors in its vast and far-flung empire of data 
centers. That sounds awesome, until you learn that the 
human brain contains several trillion connections! None the 
less, Google’s ANN is capable of rudimentary human-like 

self-learning. That means you don’t have to teach it what spam is. 
 
In one experiment, Google’s ANN was fed millions of still images of cats culled from 
YouTube videos. The images were not labeled as “cats” and programmers did not tell the 
ANN what a “cat” is. The ANN figured it out for itself, learning to recognize cats in virtually 
any image. If it can do that, it can recognize spam with greater accuracy than most 
humans can. 
 
You don't have to do anything to use Gmail's spam filtering - it's automatic. But you can 
add your own filters to funnel messages into folders, forward to another address, and other 
actions. See my article Tame Your Email With Filters for help adding filters to Gmail, 
Yahoo, Outlook.com, iCloud Mail, or AOL webmail. 
http://askbobrankin.com/tame_your_email_with_filters.html  
 
But the ANN is still not perfect. Just as humans see UFOs in pictures of streetlights, 
Google’s ANN sometimes sees spam in legitimate messages and mistakenly consigns 
them to the spam folder. Google claims that only about 0.01 percent (1 in 10,000) of 
legitimate emails are falsely labeled as spam these days. As the ANN learns more about 
email, that figure should fall even further. 
 
Take a look in your Gmail spam folder, and see how it's working. If you do find certain 
messages are being incorrectly flagged as spam, you can create a Gmail filter for them, 
with a "Never send to Spam" action, so they'll be delivered to your inbox. 
 
How does Gmail’s spam filter compare to other free Webmail services, such as Microsoft’s 
Hotmail/Outlook.com and Yahoo? I haven’t been able to find any independent, rigorous 
studies of this question. I’ll just note that Microsoft seems to think it’s acceptable if less 
than 3 percent of the messages that reach your inbox are spam. 
 
Another new spam-fighting technique that Gmail is introducing doesn’t really tackle spam, 
in my opinion. Gmail now attempts to learn individual users’ reading preferences and filter 
out even legitimate mail that goes unread. The company gives the example of email 
newsletters. One user reads them assiduously while another just lets them pile up unread, 
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or deletes them without reading. Why people don’t just unsubscribe from newsletters is 
one of life’s mysteries. Hopefully, Gmail can distinguish between legit opt-in email 
newsletters and the ones that just arrive without your consent. 
https://www.microsoft.com/en-us/outlook-com/compare/  
 
Finally, Gmail is providing help for legitimate, large-volume email publishers whose 
communications are sometimes wrongly condemned as spam. The Gmail Postmaster 
Tools will help airlines, banks, credit card companies, and other well-known firms analyze 
the fate of their emails and improve their delivery and reading rates. 
https://gmail.com/postmaster/  
 

Even if you don't use or like Gmail, you can still use it to filter spam. 
Here's one technique that some people use to "pre-filter" their incoming 
emails. Instead of providing your actual email address when asked, 
give out a Gmail address that you've created. Configure that Gmail 
account to simply forward everything to your actual address. Gmail 
does spam-filtering BEFORE forwarding, so the messages that do get 
forwarded are virtually spam-free.  

 
Gmail’s spam filter is so reliable and accurate that I hardly ever check my spam filter for 
false positives anymore. I get hundreds of emails daily, and in 2015, I estimate I’ve clicked 
on the “Report Spam” or “Not Spam” button less than a dozen times. The spam filter just 
works. 
 

 

Enliven Documents with Themes 
By Nancy DeMarte, 1st Vice President,  
Sarasota Technology User Group, FL 
June 5, 2015 issue, Sarasota Technology Monitor 
www.thestug.org 
ndemarte (at) Verizon.net 
 
 

If you often find yourself creating documents in Word or spreadsheets in Excel, you 
probably use the same font and layouts most of the time. You would be surprised how 
lively and stylish these files could be if you applied a theme to them. Themes in Word and 
Excel are Style sets that coordinate the color scheme, fonts, line and paragraph spacing, 
and effects. The Themes gallery is located on the Design tab in Word and the Page Layout 
tab in Excel. I will use Word 2013 as an example of how you can apply and customize 
themes in your documents.  
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Choose and Apply a Theme 
The default theme in Word and other 
Office programs is appropriately 
named “Office,” but you can apply a 
different theme to a document either 
during its creation or after. For 
example, I opened a blank document, 
clicked the Design tab, then Themes 
(left side of the ribbon), to open the 
Themes gallery. I chose the “Ion” 
theme, although I could have browsed 
for more online. A group of Styles that 
coordinate with this theme appeared in 
the ribbon. I chose a colorful one called 
“Lines (Simple)” and began to create 
my document.   
 
First, I typed the title and highlighted it 
to display the Font toolbox just below it. 
I clicked Styles (bottom right) and 
selected the Title style, which changed 

my title to a maroon color and 40-point text. The title seemed too large, so I reduced the 
font size to 24 points. All these font changes can also be made on the Home tab – Font 
group. 
Next, I typed an introduction and my first heading, highlighted it, chose Styles from the font 
toolbox again, and picked Heading 1. It also was a maroon color, 18 points, and included a 
line below it. I changed the size to 14 points to be consistent with the new title size. 
 
Then I typed the body of the document. After I had typed the first line of text, I clicked 
inside a word and learned that the theme’s body text was Century Gothic, 10.5 point, 
Normal style. Just for fun, I added a couple of shapes from the Shapes gallery (Insert tab – 
Shapes) Sure enough; they too were a maroon color, keeping with the theme.  
 

Customize and Save a Theme 
Next, it was time to experiment with changing a 
few of the elements of the theme. With my 
document open, I clicked the Design tab and 
then Colors, which revealed a menu of color 
schemes, each which included several 
coordinated colors. I clicked “Blue” and 
immediately found that all my maroon-colored 
features had turned a medium blue. Then I 
clicked Fonts and chose “Times New Roman – 

Arial.” The title and all the headings became the Times New Roman font, while the body 
text changed to Arial.  
 



  
DATALINE                                               October 2015                                                             13 

With my cursor still in the document, I clicked Paragraph Spacing, which displayed a list of 
preset distances between lines and paragraphs. Hovering my mouse over Default showed 
my theme’s spacing. I hovered my mouse over each of the choices to preview how it 
would affect my document. I decided on the Open spacing set, which added a little more 
space between lines and paragraphs. Because I had only a few objects or shapes in this 
document, I did not change the Effects, but clicking that icon showed me what changes 
were possible.  
 
Now it was time to save this custom 
theme. I clicked the Design tab, Themes 
button, and selected “Save Current 
Theme” at the bottom of the gallery. I 
typed a name, “My Ion,” in the dialog 
box and clicked Save. This put my 
modified theme into the Custom area 
above the Theme gallery. The theme 
was also stored as MyIon.thmx in a 
special Document Themes folder.  
 
Two Important Cautions 
 
1. Don’t confuse saving a theme with setting it as the default.  If you save your custom 
themes, you have the choice of when to use them. If you set a custom theme as the 
default, it will affect all future documents and may give 
you some unexpected results. 
 
2. The Office theme is different from the rest in the theme 
gallery in that it affects all of the Office applications. If you 
make a change to the Office theme, such as changing the 
background from white to gray, and set it as the default, it 
will affect all programs in your Microsoft account, 
including those on other computers. However, saving 
your own custom themes in Word or Excel can be a 
handy way to give your documents some style and avoid 
re-creating a favorite theme each time you need it. 
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The Meeting that Was...September 
By Judy 

 
We took a quick look at Edge; I’m still going to use Firefox although a couple of the people 
at the meeting who are using Win 10 are happy with Edge. It’s a little too austere for me 
(like Chrome). 
 
At 7:00 pm, we had our annual Genealogy presentation with Tom and Linda Tippets, Area 
Family History Addvisors – Family Search. Tom showed us several videos that were really 
informative + how to use Family Search. They offered attendees the chance to participate 
in the meeting by completing a pedigree chart with as much information as they have. 
Denny Fuerst took them up on it and Linda was able to fill in some of his blanks. It was fun 
to see the 1940 census in El Segundo where I was listed as 2/12 since I was born in 
February. The people who now own my house in El Segundo told me the only thing they 
were missiing is how much it cost to build it – the census filled in that blank with $4000. It 
was 2-bed, 1-bath when they bought it in 2011 for $650k – didn’t look much different than 
when I lived there. Last year they added a bedroom & master bath and it’s now worth over 
$900k. I took the opportunity to attend one of the Tippets genealogy classes offered at the 
Valencia Library—drove in from a tech conference in Las Vegas, turned on my A/C and 
went right to the class. I plan on completing them during their next series.  
Thanks to Helen Blancher for putting this meeting together for us. 
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                                               And, the Winners were: 
 
My eBay f 
 

  
  Logitech        
        
        
 
 
 
 
 
 
 
 
 
 
 

2015/2016 SCV CC OFFICERS 
 
President  Judy Taylour 
scvcomputerclub(at)gmail.com 
 
 
Information Line  661.513.4612 
 
Snail Mail  18727 Nadal Street 
   Santa Clarita, CA 91351 
 
General Meeting 2nd Wednesday / month 

     
  SCV Senior Center 

   22900 Market Street 
   Newhall CA 91321 

Membership Application 
(Please Print) 

 
_____________________________________ 

Name 
 
____________________________________ 

Address 
 
_____________________________________ 

City/State/Zip 
 
_____________________________________ 

Home Phone 
 
_____________________________________ 

E-mail 
 
_____________________________________ 

Areas of Interest 
 
 
Level of computer skills (please circle) 
 
Novice                   Average                Expert 
     
Mail to: SCV CC, 18727 Nadal Street, Canyon 
Country CA 91351 

 

 
Membership Benefits 

Around Town 
 

 
Mark Thomas Computer Support 

26117 Rainbow Glen Drive 
Newhall 91321 

661.250.7440 / mark@marktcs.com 
65+ = $20 discount on Onsite support 
In-your-house support also available 

iPhone / iPad screen repair 
 

Rogers System Specialist 
(Various Discounts) 

25570 Rye Canyon, Ste. A, Valencia 
661.295.5577  

Give Judy’s telephone number for the 
discount 661.252.8852 

Genealogy Online for Dummies – Agnes 
Chaney 
Measuring Tape aka YoYo – Agnes 
DVD’s - Kathryn Kazmer 
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The information appearing in this newsletter is distributed solely for use by SCV Computer 
Club members. Permission is enthusiastically granted to reprint all or any part by similar 
non-commercial publications provided credit is given to the author of the article and the 
DATALINE. 
The publication of information in this newsletter constitutes no guarantee of accuracy and 
its use by readers is discretionary. All opinions expressed are those of the authors and not 
necessarily those of the SCV Computer Club. 
The SCV Computer Club is dedicated to supporting the needs of its 
members and to the exchange of information about computers, 
peripherals, services, hardware and software through meetings, its 
web page, and the distribution of this newsletter. 
 
The SCV Computer Club is a member of SCRUGS and APCUG 
(Southern California Regional User Group Summit) 
(Association of Personal Computer User Groups) 
 
 
 
Annual membership Dues     $30.00 
Annual Family      $54.00                                   
Senior  (55)                              $27.00                                       
Senior Family (55)                                                  $48.00                                  
Student Membership                                              $25.00 
 

 
 

 

 
 

 
 

 
 
 
 

                  40% Discount 
                 
 
  
                
 
 
 
 
                  35% Discount 
                                           

 
 

           

  
O’Reilly User Group Program 

35% Discount 
                     
Free Shipping on orders of $29.95 &  up! 
  

 
            35% Discount 

One free class / member 
See Judy for Free Voucher # 

 
40% Discount 
 

30% 
Discount 

eBooks – 50% discount 

Contact Judy for Discount Info 


